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Introduction

Introduction
Chapter 1:

This chapter introduces the CyberLink Power2Go program and includes an overview
of its key features. It also outlines the available Power2Go versions, lists the
supported file and disc types, and reviews the minimum system requirements.

Note: this document is for reference and informational use only. Its content
and the corresponding program are subject to change without notice.

Welcome
Welcome to the CyberLink family of digital media tools. CyberLink Power2Go is the
all-media burning software that supports all drives and discs, including CD, DVD,
and Blu-ray Disc(TM).

With CyberLink Power2Go you can create and burn data discs, music discs, photo
gallery discs, and video discs. You can also back up your computer to a disc or
removable USB storage drive, convert media files for use on mobile devices, back
up online media to a disc or your hard drive, or use the handy disc utilities to erase
and copy discs, mount disc images as a virtual drive, and much more.

CyberLink Power2Go is the all-in-one burning software for the PC.

Key Features
This section outlines some of the key features available in the latest version of
CyberLink Power2Go.

Disc Burning

· Burn video discs* to a Blu-ray Disc, AVCHD, or DVD, or burn an existing DVD or
Blu-ray Disc folder to a disc.

· Secure your data files by burning them on a CD, DVD, or Blu-ray Disc with up
to 256-bit encryption.

· Create a music disc in a variety for audio formats.

· Make a copy of a disc that has up to 256-bit encryption.
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Media Converter

· Convert video and audio files into formats suitable for your mobile devices*.

· Output videos with the latest 4K profiles (up to 4096x2160), using the H.264
(AVC) and H.265 (HEVC) video formats.

· Choose from four types of TrueTheater video quality enhancements on
converted videos.

· Rip audio from an Audio CD, edit the audio track information, and convert the
files to a format you can use on your mobile device*.

Online Media Backup*

· Download your videos from YouTube, including 4K HDR (VP9/WebM) videos. 

· Access the videos you have stored on Vimeo and download them to your
hard drive.

· Back up your online media by burning it directly to a disc.

Latest Video and Audio Format Support

· Import H.265 video files in the MP4 or MKV format.

· Import a CUE* file to burn an audio disc complete with track listings and
album information.

· Create audio discs with audio files in the APE*, FLAC*, and OGG* formats.

· Rip an audio CD and save the files in the APE*, FLAC*, M4A* (AAC), or OGG*
audio file format.

· Convert existing audio into the APE*, FLAC*, M4A* (AAC), or OGG* file format.

System Recovery* and Virtual Drive

· Back up your computer and Windows system files on discs or removable 32
GB plus USB storage drives.

· Restore your computer from a system image on system recovery discs or a
removable USB storage drive.

· Mount a disc image file and access it as if using a real disc drive.

Photo Gallery Disc Creation*
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· Author photo gallery discs that create a photo showcase application that runs
on a PC.

· Include photo descriptions and an external URL on the disc.

Disc Manager*

· Add newly burned discs to the Disc Manager library.

· Import discs you burned previously into the Disc Manager.

· Use the Disc Manager to easily find files and discs you burned previously.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Power2Go Versions
The features that are available to you in CyberLink Power2Go are completely
dependent on the version you have installed on your computer.

To view the Power2Go version table, please go to our web site:
https://www.cyberlink.com/products/power2go-platinum/compare_en_US.html

To determine your version of CyberLink Power2Go, click on the Power2Go logo
anywhere in the program, or press Ctrl+B on your keyboard or select Help > About
Power2Go when in the new  function window.

Updating Your Software

Software upgrades and updates (patches) are periodically available from CyberLink.
CyberLink Power2Go automatically prompts you when either is available.

Note: you must connect to the Internet to use this feature.

To update your software, do this:

1. Open the Notification Center by doing one of the following:

· click the  button when it's enabled.

· click the Upgrade button in the About CyberLink Power2Go window.
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2. Click the feature you would like to upgrade to, or the patch you want to
update to.

3. A web browser window opens, where you can purchase product upgrades or
download the latest patch update.

Minimum System Requirements
The system requirements listed below are recommended as minimums for burning.
You may find that your system, while meeting these recommended minimums,
requires expanded capacity during specific burning tasks.

Minimum System Requirements

Operating System · Microsoft Windows 10, 8/8.1, 7.

Processor (CPU) · Data Burning: Intel Celeron 2.0 GHz or AMD Sempron
1.3 GHz.

· Movie Disc Burning: Intel Core 2 Duo E6400 or AMD
Phenom II X2.

Graphics
Processor (VGA)

· 128 MB VGA VRAM.

Memory · 2 GB required (4 GB or above recommended).

Screen Resolution · 1024 x 768, 16-bit color.

Hard Disk Space · 10 GB for DVD burning; 25 GB for Blu-ray Disc burning.

Burning Drive · CD/DVD/Blu-ray recordable drive is required for disc
burning purposes.

Internet
Connection

· Internet connection required for initial software and
file format activation, and Online Media Backup.

Note: the system requirements are subject to change. Go to the CyberLink
Power2Go home page at https://www.cyberlink.com for the most up-to-date
and more detailed system requirements and hardware support.
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Supported Media
Chapter 2:

The following is a list of the media file formats and optical disc types that are
supported in CyberLink Power2Go. Note that the specific media that is supported
by your version of the program is dependent on which version you have installed
on your computer.

To view the Power2Go version table, please go to our web site:
https://www.cyberlink.com/products/power2go-platinum/compare_en_US.html

Supported File Formats
This table outlines the supported file formats for both disc creation and media file
conversion.

Media Type Import Export

Video ASF, AVI, DAT, DVR-MS, FLV
(H.264), M2T (H.264), M2TS
(H.264), MKV (H.264), MKV
(H.265), MOD, MOV (H.264),
MP4 (H.264), MP4 (H.265),
MPEG, MPEG-2, MPG, MTS
(H.264), TOD, TS (H.264), VOB,
VRO, WMV, WTV* (single
channel)

MP4* (H.264 AVC), MP4*
(H.265 HEVC), WMV*

Photo BMP, JPE, JPEG, JPG, GIF,
PNG, TIF, TIFF

N/A

Audio APE, DSD Audio* (DSF, DFF),
FLAC, M4A* (AAC / ALAC),
MP3, Videos with Dolby
Digital 5.1 audio
soundtracks, Videos with
Dolby Digital Plus 5.1 audio
soundtracks, OGG, WAV,
WMA

APE*, Dolby Digital* (2ch
stereo, 5.1ch), FLAC*, M4A*
(AAC), MP3, OGG, WAV,
WMA
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Note: * this feature is not available in some versions of CyberLink Power2Go.

Supported Disc Types
CyberLink Power2Go supports the burning to the following disc types:

· CD: CD-R/RW

· DVD: DVD-R/RW, DVD-R DL, DVD+R/RW, DVD+R DL, DVD-RAM

· Blu-ray Disc: BD-R, BD-R DL, BD-RE, BD-RE DL, BDXL
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Power2Go Workspace
Chapter 3:

This chapter provides an overview of the CyberLink Power2Go workspace and the
available modes of the program. CyberLink Power2Go has several windows that
vary slightly in appearance. However these windows have several consistent
features that make your burning experience more convenient.

The CyberLink Power2Go program can run in one of two modes: 

· Power2Go Desktop Burning Gadget Mode

· Power2Go Full Program Mode 

The Power2Go Desktop Burning Gadget mode is the simpler of the two modes,
allowing you to burn discs in just two steps. The Power2Go Full Program Mode
provides access to all of the burning features, disc utilities, Online Media Backup,
and the Media Converter.

Power2Go Desktop Burning
Gadget Mode
The Power2Go Desktop Burning Gadget makes burning discs quick and easy. It sits
on your desktop (if enabled) so you can conveniently drag and drop files on to it
while you work. CyberLink Power2Go prepares the media for burning, and provides
instant burning when you are ready.

The Desktop Burning Gadget is available in all supported versions of Windows, and
uses the following icons:

Gadget Icon Power2Go Function

The Data Disc gadget. Drag and drop data files on this icon
to burn them to a disc.
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Gadget Icon Power2Go Function

The Audio CD gadget. Drag and drop music files on this
icon to burn an audio CD to disc that plays on a
conventional CD player.

The Video Disc* gadget. Drag and drop video files on this
icon to burn them to a DVD, Blu-ray Disc, or AVCHD disc.

The Copy Disc gadget. Click on  in this gadget to copy the
contents of one disc on to another. For detailed information
on copying discs, see Copy Disc.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Enabling the Desktop Burning Gadget

When you first install CyberLink Power2Go, the Desktop Burning Gadget is

automatically enabled. When it is running, the  icon displays in the Windows
notification area (system tray). Double-click on it to view the gadget, or right click
on it for more options.

If the Power2Go Desktop Burning Gadget is not running, you can enable it by
selecting the CyberLink Desktop Burning Gadget 12 option from the Windows start
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menu. You can also just press the Windows key on your keyboard and then type
"Desktop Burning Gadget".

Burning with the Desktop Burning
Gadget
To burn a disc with the Desktop Burning Gadget, do this:

1. Locate the files on your computer that you want to burn.

2. Drag and drop all of the files you want on your disc to the appropriate
Desktop Burning Gadget icon, i.e. music files to the Audio CD gadget, video
files to the Video Disc gadget, etc.

3. Click on  in the Power2Go Desktop Burning Gadget to begin the burning
process.

Desktop Burning Gadget Burning Tips

The following are some tips you should be aware of when burning with the Desktop
Burning Gadget:

· To switch between functions in the Desktop Burning Gadget, click on the
arrows on the side of the gadget.

· Click on the  icon in the bottom right of the Desktop Burning Gadget to
open a window and view a detailed list of the content to be burned.

· All music discs burned with the Desktop Burning Gadget are in the audio CD
format.

· If you drag and drop video files onto the Audio Disc icon, CyberLink
Power2Go extracts the audio from the video files for burning. 
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Configuring the Desktop Burning Gadget

Right-click on the  icon in the Windows notification area (system tray) to view a
list of options for configuring the Desktop Burning Gadget.

The list of options include:

· Always on Top: select to keep the Desktop Burning Gadget on top of any
other programs you are running.

· Start Program When System Starts: select to auto launch the Desktop Burning
Gadget whenever you turn on your computer. Deselect this option if you
don't want it to auto launch at startup.

· CyberLink Virtual Drive: click to launch the CyberLink Virtual Drive window
where you can mount image files and more. See Power2Go Virtual Drive for
more information.

· Erase Disc: select to erase a re-writable disc that is currently in the disc drive.

· Close Disc: select this option to write-protect the current disc in the drive.
Once closed, no further data can be added to the disc.

· About: select to display CyberLink Power2Go version information.

· Help: select to open this help file.

· Exit: select to close the Desktop Burning Gadget.

Power2Go Full Program Mode
The Power2Go Full Program mode is the main mode of CyberLink Power2Go. In this
mode, which displays automatically when you launch CyberLink Power2Go, you
can access all of the program's features in the new task window.
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To begin a project, just select a task at the top and then the function you want to
perform. The following is a list of the CyberLink Power2Go tasks you can access in
this mode:

Task Power2Go Function

Data Disc Use the Data Disc task to burn data files to a
CD, DVD, or Blu-ray Disc. Data files can
include any kind of document or digital file.
See Data Disc for more information.

Video Disc In the Video Disc* task window you can
create a professional looking movie DVD/Blu-
ray*/AVCHD* disc that contains your video
files. This feature also allows the burning of
DVD and Blu-ray Disc folders to a disc. See 
Video Disc for more information.

Music Disc The Music Disc task allows you to burn audio
files in the MP3*, WMA, or WAV format to a
CD or DVD. You can also extract audio from
video files for burning, create a traditional
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Task Power2Go Function

audio CD, or burn a CUE audio disc. See Music
Disc for more information.

Photo Gallery Disc Create a Photo Gallery Disc* with your photos
on a CD, DVD, or Blu-ray Disc in this task
window. These discs contain a photo
showcase application that runs on any
computer with the included viewer. See 
Photo Gallery Disc for more information.

Online Media Backup Back up the media you have shared on
YouTube and Vimeo in the Online Media
Backup task window. See Online Media
Backup for more information.

Copy Disc You can use the Copy Disc task to make an
exact copy of a disc if you have more than
one disc drive in your computer. You can also
create or burn a disc image in this task
window. See Copy Disc for more information.

Media Converter Convert all your video and audio files,
including audio on a CD, for use on mobile
devices using the Media Converter. In this
function you can also rip audio and access
the audio converter. See Media Converter for
more information.

Utilities From the Utilities task window you can access
a number of useful features, including the
Disc Manager, erase disc, and also create a
system recovery* backup on a disc or
removable USB storage drive. This window
also provides access to the CyberLink Virtual
Drive and is where you can create and burn
mixed and CD extra discs. See Utilities for
more information.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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New Function Window
When you select a function in the new task window, the program displays as
follows:

Note: some functions will display a different window and are covered in
detail in other parts of this help.

A - Search Pane, B - Media Pane (Media on Your Computer/Online Media), C - Search Field, D -
Upgrade, E - Select Disc Burner, F - Next Button, G - Content Area (Media to be
Burned/Downloaded/Converted), H - Disc Capacity Indicator
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Using the Search Pane

The search pane is where you browse to or filter the content you want to burn,
convert, etc. The search pane may have any of the following tabs to help you find
your content: Browse, Filter, Media, Online Media.

Note: you can also enter in keywords in the search field to search for music,
video, and data files in the Power2Go library. See Library Preferences for
information on how to make music, video, and data files searchable by
adding folders to the Power2Go library.

Browse Tab

On the Browse tab you can navigate through the drives and folders on your
computer. It is similar to Windows Explorer, and when you select a folder, the files
(in the supported format for the selected disc type) display in the media pane.

Filter Tab

The Filter tab is available when you are burning data discs. On this tab you can filter
the type of data files you want to include on your disc to simplify the search
process.

Select All files if you want to view all the files in a folder, or select Custom files and
then select the file types from the list you are searching for. Click Edit to customize
the list of file extensions that CyberLink Power2Go uses to filter. You can add or
remove file extensions from the filter list by selecting the Edit button and making
the changes as required.

Media Tab

Use the Media tab when creating music discs to quickly find the music files you are
looking for. CyberLink Power2Go uses the Power2Go library service to categorize
your music by artist, album, genre, year, and recently added.
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Note: you can set the music that is available in the Power2Go library by
adding folders on the Library preferences tab. See Library Preferences for
more information.

Online Media Tab

When in the Online Media Backup window, the Online Media tab is the only option
available in the search pane. In it you can log in to your YouTube and Vimeo
accounts and then browse to and back up the media files on these online media
web sites. See Online Media Backup for more information.

Power2Go Projects
When creating a data, video, music, or photo gallery disc, you can save your
progress as a new project in the P2G format. This allows you to complete the
burning at a later date, or burn the same disc again.

To save your disc project, select Project > Save or Save As from the menu. To open
a project you created previously, select Project > Open from the menu in the new
function window.
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Data Disc
Chapter 4:

The Data Disc option allows you to burn data files to a CD, DVD, or Blu-ray Disc.
Data files can include almost any kind of document or digital file. You can also
create a secured data disc if you are burning sensitive content to a disc.

Creating and Burning Data
Discs
To burn a data disc, do this:

1. In the new task window, click the Data Disc option and then select the type of
disc (CD, DVD, Blu-ray Disc) you want to create. The Data Disc window opens.

2. Use the search pane (see Using the Search Pane for more information) to find
the files you want to include on your disc.

Note: for best search results, make sure you set up the Power2Go library
before creating a data disc. Once you do this, the data files in the library
become searchable when you enter keywords into the search field. See 
Library Preferences for more information.

3. Select the files or folders you want to burn and then drag and drop them in
the content area.

Note: you can also click the  button to add the data files or click the 
button to create a folder on the disc.

4. After you have added all of the content that you want to burn, click the Next
button.

5. If required, adjust the options in General settings and the Burning Options.

6. Click Burn when you are ready to burn your disc.
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Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

7. When the burning is complete, select any of the following options in the
window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Burning a Secured Data Disc
The secured data disc option allows you to burn password-protected data files to a
CD, DVD, or Blu-ray Disc.

You can also burn secured data discs with encrypted file names. The encrypted file
names are hidden from users, unless they enter the correct password. You can
choose to secure all or only some of the files on a data disc.

To burn a secured data disc, do this:

1. In the new task window, click the Data Disc option and then select the type
of disc (CD, DVD, Blu-ray Disc) you want to create. The Data Disc window
opens.
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2. Click the  button.

3. Select the level of security for the disc: Secured (128-bit) or Highly secured
(256-bit).

4. Enter a Password for your secured data disc. Re-enter the password again in
the Confirm password field and, if required, include a Password reminder,
which can assist you if you ever forget it.

5. Select the Hide the file names on a secured disc checkbox if you want to
encrypt the file names on the disc.

6. Click OK. Note that the content area is split into two sections.

7. Use the search pane (see Using the Search Pane for more information) to find
the files you want to include on your disc.

Note: for best search results, make sure you set up the Power2Go library
before creating a secured data disc. Once you do this, the data files in the
library become searchable when you enter keywords into the search field. See
Library Preferences for more information.

8. Select the files or folders you want to burn and then drag and drop them to
either the secured data area (indicated in pink) or the regular non-secured
data area (indicated in blue).

Note: you can also click the  button to add the data files or click the 
button to create a folder in the last disc area you selected.

9. Once you have added all of the content that you want to burn, click the Next
button.
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10. If required, adjust the options in General settings and the Burning Options.

11. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

12. When the burning is complete, select one of the following options in the
window box that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Viewing Content on a Secured Disc
When you burn data to a secured disc with CyberLink Power2Go, the CyberLink
Secure Browser is included on the disc so that you can view the content on the disc.

1. When you insert a secured data disc into the disc drive, the CyberLink Secure
Browser prompts you for a password.
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Note: if the CyberLink Secure Browser does not automatically launch when
you insert a secured data disc, try navigating to the disc in Windows Explorer
and then double-click on the disc in the drive to launch it manually.

2. Enter your password and then click OK to display the CyberLink Secure
Browser window.

Note: if you selected to Hide the file names on a secured disc when creating
the disc, double-click on the secured folder in the list view to view the files.

3. In the CyberLink Secure Browser, you can perform the following functions:

· Click  to view a file in its default program.

· To extract files from the disc and save them to a computer, select them and

then click .
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Note: if your secured data disc has multiple sub folders, click  to go up
one level to the previous folder.

· Click  to search for files. Type part or all of the file name or folder in the
field provided. When searching you can click Size to look for files of a specific
size, or Modified Date to look for files that were created or modified on or
between specific dates.

Note: to change the view of the items in the CyberLink Secure Browser, click

.
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Video Disc
Chapter 5:

The Video Disc* option allows you to burn video files to a DVD, Blu-ray, or AVCHD
disc, with a stylish disc menu.

Note: see Supported File Formats for a list of the video file formats you can
import when creating a video disc.

You may also burn a DVD or Blu-ray Disc folder to a disc.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Burning a Video Disc
When you select the DVD-Video Disc, Blu-ray Disc, or AVCHD option in the new
task window, the create disc window displays.

A - Disc Content Tab, B - Menu Preferences Tab, C- Disc Preferences Tab, D - Disc Menu Font
Properties, E - Disc Menu Preview Window, F - Burn to Disc, G - Preview Disc Menu, H - Disc Menu
Properties, I - Menu Navigation Controls, J - Toggle Capacity Display, K - Disc Content
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The steps to create and burn a video disc may vary depending on your
requirements. The following sections outline all of the features you can perform in
the create disc window, so consult the sections that apply to the disc you want to
create.

Creating a Video Disc
To create a video disc, do this:

1. In the new task window, click the Video Disc option. Select the DVD-Video
Disc, Blu-ray Disc, or AVCHD option to open the create disc window.

2. Click the  button and then browse to and select the video file that
you want to include on the disc.

3. If an imported video has a 9:16, 1:1, or similar aspect ratio, click the 
to apply a blur effect on the black areas of the video, using InstaFill. Once
selected, click the Enable option and choose whether to Apply to All similar
videos on the disc.

4. Click the  button to import additional video files if required. Each
video you import becomes another title or scene on your final disc.

5. Click on  to preview the imported videos, if required.

6. Proceed to complete the disc creation process as required. See 
Selecting/Editing Disc Menus for more information.

Selecting/Editing Disc Menus

Once you have added all of the content that you want on your disc, click on the 
Menu Preferences tab to edit the existing disc menu or select another disc menu
template.

All the disc menu templates in CyberLink Power2Go are multi-layered, and consist
of the following pages:

· a main menu home (root) page.

· a scenes page that lets you select the individual titles (videos) on your disc.
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Selecting Disc Menu Templates

CyberLink Power2Go provides you with several stylish pre-designed menu
templates that you can choose from. These menus are already customized for you
and may include such features as motion and menu music.

Note: if you do not want to include a menu on your final disc, select the No
Menu template on the Menu Preferences tab.

Select a menu template to preview it. Select Apply to apply the highlighted menu
page style to the specified menu page. Select Apply to All Pages if you want to use
the same style on every page (home and scenes page).

Note: if required, you can click Download to go to DirectorZone, where you
can download and import additional disc menu templates.

Editing Disc Menu Properties

CyberLink Power2Go lets you edit some of the disc menu’s properties. Use the
menu navigation controls to preview the design and behavior of the current disc
menu.

If you want to view the scenes on your disc, use the  button and the other
menu navigation controls to navigate through the disc menu. Or click the Preview
button at the bottom of the window to view what your disc will look like when
played on a disc player after burning.

Editing Disc Menu Text

To edit the text that appears on the menu page, including clickable button text,
double-click on it, and then enter the new text. You can modify menu text style,
size, and alignment using the disc menu font properties options located at the top
of the disc menu window.

To change the position of any text on your menu, just click and drag it to the new
position.
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Setting Disc Menu Background Music

Some of the pre-designed disc menu templates contain menu music. In the disc
menu properties are you can:

· click on  to edit or replace the menu’s background music.

· click  to remove the current background music from the menu.

Adding/Editing Disc Menu Music

If you are using background music in your disc menu, click the  button to
perform the following functions:

Note: the final duration of your disc menu’s background music is dependent
on the time entered in the Duration field in the Playback Mode Settings
window, not the length of music file used. See Setting Disc Playback Mode
for more information on setting your menu’s duration.

· click the  button to add/replace the menu background music.

· trim the audio file using the playback controls and then move the sliders on
the trim bar to the desired start and end points.

· select to have the menu music gradually Fade-in or Fade-out.

· if the length of your menu music file is not as long as the specified duration,
select the Auto repeat option to loop it.

· click Apply to All Pages to set the music for all of the disc menu pages, or click
Apply to set it for the current disc menu page you are editing.

Adding a First Play Video

Use this option to add a video as a first play video to your created disc. The first play
video plays automatically when the disc is inserted into a disc player, before the
disc menu loads. No navigation buttons are available during the first play, and
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viewers cannot fast forward past this segment. In a professional production, this is
usually a copyright notice or warning. However, you may prefer to use a personal
introduction or other video clip instead.

To set a clip as first play, do this:

· click  and select the video that you want.

· click  to remove the video set as the first play video.

· click  to preview the first play video.

Setting Disc Playback Mode

Click the  button to set how the disc plays back in a disc player. Select from
one of the available playback modes in the list.

In the Playback Mode Settings window you can set the following:

· choose from one of the three available playback modes based on the
available descriptions. Your disc will follow the selected behavior when
inserted or play is pressed on your disc player.

· if you want the disc content to play automatically, select the Auto menu time
out option. When selected, your disc content plays automatically after
displaying the disc menu for the specified duration. If you do not select this
option, your menu loops endlessly until you press the play button on your
disc player.

· in the Duration field, enter in the length in seconds for the disc menu. The
minimum duration allowed is 10 seconds, while your disc menu can be up to
99 seconds long before it loops back to the beginning.

Note: the duration you enter is also the length of your menu’s background
music, even if the selected music file’s length is longer than the duration
specified.
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Specifying Buttons Per Page

When creating a disc with multiple titles /scenes, you can select the number of
thumbnail buttons that display on the scenes menu page. Use the Buttons per page
drop-down at the bottom of the Menu Preferences tab, to select the number you
want on these pages.

Note: the number of thumbnail buttons that can display on each menu page
is dependent on the design of the menu template. 

Select Add thumbnail index to add numbering of your thumbnails to your menu
page.

Editing Disc Preferences

Before you burn a disc you should configure your disc preferences, including disc
and video file format, audio format, etc. Click on the Disc Preferences tab to
configure your disc’s preferences.

The following preferences are available on the Disc Preferences tab:

Disc Format

· the format of your disc was determined by the option you selected on the
new task page (DVD-Video Disc, Blu-ray Disc, AVCHD). Depending on the
disc format that you selected, there may be a drop-down option to select the
capacity of the disc or an option to burn to a removable disk. For example, for
AVCHD you can burn the video to a removable disk, SD/SDHC/SDXC card, or
memory stick.

Video and Audio Settings

· Select the video recording format: if available for your selected disc format,
select the recording format of the video on your disc and its aspect ratio.

· Select the video encoding format and quality: if available for your selected disc
format, select an encoding format and video quality for your disc. The Smart
Fit option automatically adjusts the bitrate to the best quality video file that
fits exactly to the capacity of the disc you are using.
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· Select the audio encoding format and channels: select an audio format for
your disc, and the number of channels it is capable of outputting to.

Note: the video quality and audio type options that are available depend on
the disc format that you have selected.

· TV Format: select the TV format (NTSC or PAL) for your video. This format
should correspond to the region in which you plan to play your video disc.

Burning Video to Disc
Burning the disc is the final stage of the create disc process. Once your disc is
burned, you are able to play it on a disc player.

Note: before burning your disc, select Burning > Settings from the menu (or
Ctrl+I on your keyboard) to configure the video settings. See Configuring
Video Settings for more information.

To burn your video to disc, do this:

1. In the create disc window, click on the Burn button.

2. Configure the production preferences as follows:

· Current drive: the burning drive (or removable disc for the AVCHD format)
CyberLink Power2Go will use to burn the production to disc. If necessary, click

the  button to select another drive and configure the burn settings. See
Configuring Burn Settings for more information. If you are burning your

production to a rewritable disc, you can click  to erase it. See Erasing
Discs for more information.

· Disc volume label: in the field provided, enter a label for your disc. The disc
label can be up to 16 characters long.

· Burn to disc: ensure this option is selected if you want your production
burned to a disc. 

· Number of copies: in the field provided, enter the number of discs you want
CyberLink Power2Go to burn for you in succession.
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· Create a folder: select this option to create a disc folder on your computer that

contains all the files necessary for burning. Click on  to specify the folder
where it is created. Creating a folder overwrites all of the existing data in a
directory.

· Disc Manager Tags: click on this button to add keyword search tags that you
can use to find the disc later in the Disc Manager library. See Using the Disc
Manager for more detailed information.

· Enable x.v.Color: x.v.Color is a color system that can display a wider color
range than usual. CyberLink Power2Go can generate an x.v.Color-compliant
stream, which is backward compatible with RGB displays, while offering the
opportunity to achieve better visual quality if your playback environment is
x.v.Color ready.

· Enable hardware video encoder: enable this option to speed up rendering and
burning time. This option is only enabled if your computer supports hardware
acceleration (NVIDIA graphics card that supports CUDA, an AMD graphics card
that supports AMD Accelerated Parallel Processing, or a computer with Intel
Core Processor Family technology).

3. Click on Start Burning to begin the burning process.

Note: the burning process may take at least a few minutes, depending on the
length and quality of your video, and your computer’s processing power. Be
prepared for a short wait while CyberLink Power2Go renders your video disc.
Select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

Configuring Burn Settings

Before you burn to a disc for the first time, it is advised that you click on  to
set your burning configuration as follows:

· Recording drive: select the burning drive CyberLink Power2Go will use to
burn the production to disc.

· Recording speed: set the recording speed used when burning the disc. If you
encounter errors during the burning process, try lowering the burning speed.
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· Include buffer under-run protection: select this option to ensure that video is
written to disc without interruption. An interruption in video burning can
result in an unusable disc.

After you set this configuration, CyberLink Power2Go uses the same configuration
each time you burn until you change the settings.

Erasing Discs

If you are using a rewritable disc, you can erase content that has data previously
recorded on it. This allows you to reuse the same discs over and over without the

need to continually buy new discs. Click on the  button to begin erasing a
disc.

When erasing a disc, select:

· the Quick erase option to erase the disc index contained on the disc.

· the Full erase option to erase all of the content the disc contains.

Burning a DVD/Blu-ray Disc
Folder
Use the Burn DVD Folder and Burn Blu-ray Disc Folder features to burn previously
created disc folders to a DVD or Blu-ray Disc.

To burn a DVD or Blu-ray Disc folder, do this:

1. In the new task window, click the Video Disc option. Select the Burn DVD
Folder or Burn Blu-ray Disc Folder option to open the Burn DVD/Blu-ray Disc
Folder window.

2. Click  and then select the DVD/Blu-ray Disc folder on your computer that
you want to burn to a disc.

3. Enter a Disc name in the field provided.

4. Insert your disc and then select your drive in the drop-down list.

5. If required, set the Write speed and the Number of copies you want to burn.
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6. Select Perform write simulation if you want CyberLink Power2Go to simulate
the burning process first to ensure the burn will finish successfully.

7. Click Burn to start the burning process.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

8. When burning is complete, select an option in the window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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Music Disc
Chapter 6:

The Music Disc option allows you to create an MP3 or WMA CD/DVD with your
music files, or create a traditional audio CD that plays back on a regular CD player.
You can also import a CUE file (and its associated audio file) to create a CUE audio
disc.

Note: see Supported File Formats for a list of the audio file formats you can
import when creating a music disc.

Burning an Audio CD or
MP3/WMA Music Disc
To burn an audio music CD or MP3/WMA music disc, do this:

1. In the new task window, click the Music Disc option and then select the type
of music disc you want to create (Audio CD, WMA CD, MP3 CD, WMA DVD,
MP3 DVD). The music disc window displays.

2. Use the search pane (see Using the Search Pane for more information) to find
the music you want to include on your disc.

Note: for best search results, make sure you set up the Power2Go library
before creating a music disc. Once you do this, the music files in the library
are organized for you on the Media tab in the search pane and become
searchable using the search field. See Library Preferences for more
information.

3. Select the files you want to burn and then drag and drop them in the content
area.
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Note: you can also click the  button to add the music files or the other
available buttons to reorder and preview the music on the disc. If you want to
extract the audio from a video clip and include it on your music disc, simply
add the video clip to the disc.

4. If you would like to edit or add effects to a music file, select it and then click

the  button to edit it in CyberLink WaveEditor*. Please consult the help file in
CyberLink WaveEditor for detailed information on editing audio in that
program. Once you finish editing an audio file, the updated file is placed back
in the content area.

5. If required, click the Edit button to set the disc's audio quality, add CD-Text,
and more. If creating an audio CD, see Audio CD Preferences. See MP3/WMA
Disc Preferences if creating an MP3/WMA music disc.

6. Once you have added all of the content you want on your disc, click the Next
button.

7. If required, adjust the options in General settings and the Burning Options.

8. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

9. When the burning is complete, select one of the following options in the
window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.
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Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Audio CD Preferences
When creating an audio CD, click the Edit button to access the following
preferences:

· Enable CD-Text: select this option if you want to add information about the
music disc you are creating. Enter the desired information in the fields
provided.

· Normalize volume of all tracks on the CD: select this option to set the volume
of all of the audio tracks on the CD to the same level.

· Insert audio gap between tracks: enter the duration, or silence, between each
track in seconds in the field provided.

When you are done modifying the preferences, click OK to save the changes for
your audio CD.

MP3/WMA Disc Preferences
When creating an MP3 or WMA disc, click the Edit button to access the following
preferences:

· Quality: select the sound quality of the MP3/WMA files that are burned to the
disc from the drop-down.

· Auto-generate playlist for Windows Media Player: select this option if you
want CyberLink Power2Go to create a Windows Media Player playlist with the
songs that will be on your disc.
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· Normalize volume of all tracks on the CD: if creating an MP3/WMA CD disc,
select this option to set the volume of all of the audio tracks on the CD to the
same level.

· Add numeral prefix for the playback order: select this option if you want to
add a numeral prefix to the music disc. Enabling this will set the song
playback order to how the music files are displayed in the content area.

When you are done modifying the preferences, click OK to save the changes for
your MP3/WMA disc.

Burning a CUE Audio Disc
In the Music Disc option you can import a CUE file (and its associated audio) to
create and burn a CUE audio disc. A CUE file is a metadata file that lists the order of
the tracks in an associated audio file and other information. When imported into
the CUE Audio Disc window, all the audio information, including album and artist
name, and track information, is auto loaded for you if available in the CUE file.

To burn a CUE audio disc, do this:

1. In the new task window, click the Music Disc option and then select the CUE
Audio Disc. The CUE Audio Disc window displays.

2. Click on  to import a CUE file. Browse to the location of the CUE file,
select it, and then click Open to import.

Note: the CUE file's associated audio file must be in the same folder as the
CUE file and have the same file name. The associated audio file can be in
either the FLAC or APE audio file format.

3. Insert your disc and then select your drive in the drop-down list.

4. If required, select a Write speed for the burning disc. The speed you should
select will depend on the burning drives you are using and the quality of the
discs.

5. Enter the Number of copies you want to burn.

6. If available, you can use the following options to assist with the burning
process:
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· select Perform write simulation if you want CyberLink Power2Go to simulate
the burning process first to ensure the burn will finish successfully.

· if available, select Verify recorded data if you want CyberLink Power2Go to
verify that the content was successfully burned to the disc.

· if available, select Enable defect management to have CyberLink Power2Go try
to fix any defects on a disc so that content burns correctly.

7. When you are ready to burn the disc, click the Burn button.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

8. When the burning is complete, select one of the following options in the
window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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Photo Gallery Disc
Chapter 7:

Choose the Photo Gallery Disc* option to use your photos to create a dynamic
slideshow that is burned as a stand-alone photo showcase application on a CD,
DVD, or Blu-ray Disc.

Note: see Supported File Formats for a list of the photo file formats you can
import when creating a photo gallery disc.

The photo gallery runs on any computer with the included viewer, and can include
photo descriptions and an external URL on the disc.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Creating and Burning Photo
Gallery Discs
When the Photo Gallery Disc option, you are essentially creating a photo album on
a disc. You can create more than one album on a single photo gallery disc.

To create and burn a photo gallery disc, do this:

1. In the new task window, click the Photo Gallery Disc option and then select
the type of disc (CD, DVD, Blu-ray Disc) you want to create. The Photo Gallery
Disc window opens.

2. In the Disc Compilation pane, if required, enter a custom name for the photo
album that will appear on the disc.

3. Use the search pane (see Using the Search Pane for more information) to find
the photos you want to include on your disc.

4. Select the photos you want to burn and then drag and drop them in the

content area. Click the  button to switch to the thumbnail view to make it
easier to find the exact photos you are looking for.
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Note: you can also click the  button to add the photos. Ensure that you
have the album you want to add the photos to selected in the Disc
Compilation pane before adding your photos.

5. Repeat the last two steps to add more photos to an album as required. You

can also click the  button to create a new album on the disc.

6. If required, click the Edit button to set the gallery title, background image, and
more. See Photo Gallery Disc Preferences for more information.

7. After you have added all of the photos you want on your disc, click the Next
button.

8. If required, adjust the options in General settings and the Burning Options.

9. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

10. When the burning is complete, select one of the following options in the
window box that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.
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Note: * this feature is not available in some versions of CyberLink Power2Go.

Photo Gallery Disc Preferences
When creating an photo gallery disc, click the Edit button to access the following
preferences:

· Gallery title: enter in a title for your photo gallery. The title displays on your
disc after it is burned.

· Custom Logo: click on the Custom Logo button to customize the logo used in
your photo gallery, as follows:

§ Don't include logo in photo gallery: select this option if you don’t want to
include a logo in your created photo gallery.

§ Include logo in photo gallery: select this option if you want to include a

logo in your created photo gallery. Click the  button to select an
image to use as the logo, replacing the default CyberLink logo.

§ Include URL link on logo: select this option if you want to include a URL
link on the logo. Once selected, enter the URL address in the field provided
(https://). When users click on the logo in the created photo gallery, they
are taken to the specified URL.

§ Click OK to save your changes.

· Slideshow speed: enter the duration, in seconds, you want each photo or slide
to display when your photo gallery is played as a slideshow.

· Background image: click the Change button to set the image that is used as
the background in the photo gallery. If none of the default images suit your
gallery disc, click the Browse button to use your own custom image.

· Display EXIF information: if the images were taken with a digital camera that
supports EXIF, select this option if you want the image details displayed in
your photo gallery disc.

· Add background music: if you want music to play in the background as users
browse through your photo gallery disc, select this option and then click
Browse to select the music file you want to use.
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· Include editor’s note: if you want to include a note or description about your
photo gallery, select this option, click Edit, and then enter the Title and
Content (note/description) in the fields provided.

· Include external URL: if you want to include a web site link on the photo
gallery disc, select this option, click Edit, and then enter the web site Name
and URL (https://) in the fields provided.

· Click the Preview button if you want to view what your photo gallery disc will
look like once it is burned to a disc. Click Export to create the stand-alone
photo gallery application in a folder on your hard drive.

When you are done modifying the preferences, click OK to save the changes for
your photo gallery disc.

Viewing Photo Gallery Discs
Once you create a photo gallery disc, to view it all you need to do is insert the disc
into a computer’s disc drive. The photo gallery viewer will play the disc
automatically.



41

Photo Gallery Disc

If your disc does not play automatically or you exported the application to your
drive, just browse to the CL_Gallery.exe on the disc/hard drive and double-click it to
view the photo gallery.
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Online Media Backup
Chapter 8:

Use the Online Media Backup* option to access the media you have on YouTube
and Vimeo, and download it to your computer's hard drive. You can also back this
media up by burning it directly to a CD, DVD, or Blu-ray Disc.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Backing Up Online Media to
Discs
To back up online media to a disc, do this:

1. In the new task window, click the Online Media Backup option and then select
the type of disc (Back up to CD, Back up to DVD, Back up to Blu-ray Disc) you
want to use. The Online Media Backup window opens.

2. In the search pane, select one of the available online media web sites to look
for media to back up. The available options are as follows:

Note: you can also search for specific videos on YouTube and Vimeo by
entering in keywords in the search field in the top left of the window.

· YouTube: click on this option to browse and back up videos from YouTube. If
you select the Favorites, Playlist, Subscriptions, or My Videos options, you
must log in with your YouTube account and give CyberLink Power2Go
permission to access your account before you proceed. You don't need to log
in to access the Most Viewed option.

· Vimeo: click on this option to browse and back up the videos that are on
Vimeo. You must log in to your Vimeo account and give CyberLink Power2Go
permission to access your account before you proceed.

Note: you can double-click on a video or photo to view it in your default web
browser.
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3. Select the media you want to back up and then drag and drop it in the
content area.

Note: you can also click the  button to add the media or click the 
button to create a folder on the disc.

4. If you are backing up videos, right-click on each video thumbnail in the
content area and then select Format & Resolution to select the video
resolution of the file that will be burned to the disc.

Note: click the  button to switch to the list view to make it easier to view
the resolution, file format, and more in the content area. The video
resolutions and formats that are available is dependent on the original quality
and format of the video you are backing up.

5. After you have added all of the content that you want to burn, click the Next
button.

6. If required, adjust the options in General settings and the Burning Options.

7. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

8. When the burning is complete, select any of the following options in the
window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager.
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Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Downloading Online Media to
Hard Drive
To download online media to your computer's hard drive, do this:

1. In the new task window, click the Online Media Backup option and then select
the Download to HDD. The Online Media Backup window opens.

2. In the search pane, select one of the available online media web sites to look
for media to download. The available options are as follows:

Note: you can also search for specific videos on YouTube and Vimeo by
entering in keywords in the search field in the top left of the window.

· YouTube: click on this option to browse and download videos from YouTube.
If you select the Favorites, Playlist, Subscriptions, or My Videos options, you
must log in with your YouTube account and give CyberLink Power2Go
permission to access your account before you proceed. You don't need to log
in to access the Most Viewed option.

· Vimeo: click on this option to browse and download the videos that are on
Vimeo. You must log in to your Vimeo account and give CyberLink Power2Go
permission to access your account before you proceed.

Note: you can double-click on a video or photo to view it in your default web
browser.

3. Select the media you want to download and then drag and drop it in the
content area.
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Note: you can also click the  button to add the selected media, or click the

 button to create a new folder in the download folder on your computer's
hard drive.

4. If you are downloading videos, right-click on each video thumbnail in the
content area and then select Format & Resolution to select the video
resolution of the file that will be downloaded.

Note: click the  button to switch to the list view to make it easier to view
the resolution, file format, and more in the content area. The video
resolutions and formats that are available is dependent on the original quality
and format of the video you are backing up.

5. After you have added all of the content that you want to burn, click the Next
button.

6. If required, adjust the options in General settings and the Burning Options.

7. Click Download when you are ready to download the media.

8. When the download is complete, select any of the following options in the
window that opens:

· Click Done to close the window.

· Click Open Folder to open the folder on your computer's hard drive where the
media files were downloaded to.
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Copy Disc
Chapter 9:

The Copy Disc function allows you to make an exact copy of a disc. However, you
must copy the disc contents onto a blank disc of the same disc type. You cannot,
for example, copy content from a CD onto a DVD. The Copy Disc function also
allows you to save or burn disc images.

Note: some discs may not be copied if they are copy-protected or contain
errors.

Copying Discs
With CyberLink Power2Go you can copy and burn the entire contents of a disc onto
another disc. You can perform this function in both Power2Go Full Program mode
and using the Desktop Burning Gadget. Only the first step for opening the Copy
Disc window is slightly different.

To copy a disc, do this:

1. Open the Copy Disc window by:

· selecting the Copy Disc option, and then Copy Disc in the new task window
when in Power2Go Full Program mode. 

· selecting the  button on the Desktop Burning Gadget until the Copy Disc

gadget displays, and then clicking on  to open the Copy Disc window.

2. Select your source and target drives using the From and To drop-downs.

3. Select a Read speed and Write speed for each disc. The speeds you should
select will depend on the burning drives you are using and the quality of the
discs.

4. Select Ignore reading error if you want CyberLink Power2Go to copy the disc
even if errors are encountered.

5. Select the Copy to hard disk option, if available, to also save a copy of the disc
to your computer’s hard drive.
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6. Select Copy whole disc if you want to copy the entire contents of the disc
onto the destination disc.

7. Enter the Number of copies you want to burn.

8. If available, you can use the following options to assist with the burning
process:

· select Perform write simulation if you want CyberLink Power2Go to simulate
the burning process first to ensure the burn will finish successfully.

· if available, select Verify recorded data if you want CyberLink Power2Go to
verify that the content was successfully burned to the disc.

· if available, select Enable defect management to have CyberLink Power2Go try
to fix any defects on a disc so that content burns correctly.

9. Select Encrypt the disc copy if you want the burned copy to be password-
protected. Once selected:

· Select the level of security for the disc: Secured (128-bit) or Highly secured
(256-bit).

· Enter a Password for your secured data disc. Re-enter the password again in
the Confirm password field and, if required, include a Password reminder,
which can assist you if you ever forget it.

· Select the Hide the file names on a secured disc checkbox if you want to
encrypt the file names on the disc.

· Click OK to save your changes.

10. Click Copy to begin the copy and burn process.

11. When burning is complete, select an option in the window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.
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Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Saving a Disc Image
Saving a disc image is useful if you want to back up your discs on your computer’s
hard drive.

To save a disc image, do this:

1. In the new task window, select the Copy Disc option and then Save Disc
Image.

2. Insert a disc into the disc drive and then, if necessary, select your source drive
in the From drop-down.

3. Select Ignore reading error if you want CyberLink Power2Go to copy the disc
even if errors are encountered.

4. Select Copy whole disc if you want to save the entire contents of the disc in
the image file.

5. Click  to set the folder where you want to save the image, and then enter
in an image file name if required.

6. Choose the file format for the image file (P2I or ISO) from the Save as type
drop-down.

7. Click Save to save the disc image.

8. When the save is complete, select an option in the window that opens:

· Click View Log to view the log. The log opens in your default TXT editor, where
you can view and save it.
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· Click OK to close the window.

Burning a Disc Image
A disc image is a file on your computer that is the duplicate of the contents and file
structure of a disc. CyberLink Power2Go lets you burn a disc image (in the ISO, P2I,
and RDF formats) to a disc.

Note: you can view the contents of an image file using the CyberLink ISO
Viewer. See Using the CyberLink ISO Viewer for more information on this
feature.

To burn a disc image, do this:

1. In the new task window, select the Copy Disc option and then Burn Disc
Image.

2. Click  to select the disc image you want to burn to a disc.

3. Insert your disc and select your drive in the drop-down in the To section.

4. Select a Write speed for burning the disc. The speed you should select will
depend on the burning drive you are using and the quality of the disc.

5. Enter the Number of copies you want to burn.

6. If available, you can use the following options to assist with the burning
process:

· select Perform write simulation if you want CyberLink Power2Go to simulate
the burning process first to ensure the burn will finish successfully.

· select Verify recorded data if you want CyberLink Power2Go to verify that the
content was successfully burned to the disc.

· select Enable defect management to have CyberLink Power2Go try to fix any
defects on a disc so that content burns correctly.

7. Click Burn to start the burning process.
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Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

8. When burning is complete, select an option in the window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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Media Converter
Chapter 10:

With the Media Converter you can convert video and audio files into formats
suitable for your mobile devices. You can also rip audio from your CDs and then
transfer it to your device in one step. This function is also where you can rip audio
to your hard drive and convert audio files for use on your computer.

Note: see Supported File Formats for a list of the file formats you can both
import and export (convert/rip files to) when using the Media Converter.

Converting Videos for Mobile
Device
To convert video files and then transfer them to a mobile device*, do this:

Note: * this feature is not available in some versions of CyberLink Power2Go.

1. In the new task window, click the Media Converter option and then Video to
Mobile Device. The Video to Mobile Device window displays.

2. Use the search pane (see Using the Search Pane for more information) to find
the video files you want to convert.

Note: for best search results, make sure you set up the Power2Go library
before converting. Once you do this, the video files in the library become
searchable when you enter keywords into the search field. See Library
Preferences for more information.

3. Select the files you want to convert and then drag and drop them in the
content area.

Note: you can also click the  button to add the video files.
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4. If required, click the  button to enable any or all of the following video
quality enhancements on the converted video:

· CyberLink TrueTheater AutoLight: select to dynamically adjust the video's
brightness and contrast ratios.

· CyberLink TrueTheater Denoise: select to reduce the amount of video noise.

· CyberLink TrueTheater HD: select to up scale the original video to a higher
resolution version, which is sharper and artifact-free.

· CyberLink TrueTheater Color: select this option to dynamically adjust the
color saturation ratio in video, making it more vivid, without affecting skin
tones.

Click OK to close the Video Quality Enhancements window.

5. Once you have added all of the video files you want to convert, click the Next
button.

6. If required, connect your mobile device to your computer. CyberLink
Power2Go should detect your device automatically. If it doesn't, try clicking
the Auto Detect button or manually selecting the device brand and model
from the drop-downs.

7. Select the Preset media format profile you want to use to convert the video
files from the drop-down. You can also select Smart Detect if you want
CyberLink Power2Go to automatically select the best format and resolution
for you based on the source video and intended device. If you want to create
your own profile, select Custom and then customize as follows:

Note: the Smart Detect and Custom options are only available if a device
brand and model are selected.

· Video format: if available, select from the available video file formats.

· Resolution: if required, select the resolution and of the converted video from
the drop-down.

· Audio format: if available, select the converted video's audio format from the
drown-down.

Click OK when done to use the custom profile.



53

Media Converter

8. If required, click the  button to change the folder where the converted
video files are saved to before they are transferred to your mobile device.

9. If required, set the conversion settings as follows:

· Transfer to connected mobile device after conversion: select this option if you
want CyberLink Power2Go to transfer the converted video files to a connected
mobile device once it has converted the files.

Note: if converting media for a connected Apple device, the Add converted
files to iTunes Library option is available instead. 

· Hardware video encoder: select this option to speed up the conversion
process by using hardware acceleration to encode the video during the
conversion process. This option is only available if your computer supports
Intel Quick Sync Video, NVIDIA CUDA, or AMD Accelerated Parallel Processing
technology .

10. If required, enable any or all of the following video quality enhancements:

· CyberLink TrueTheater AutoLight: select to dynamically adjust the video's
brightness and contrast ratios.

· CyberLink TrueTheater Denoise: select to reduce the amount of video noise.

· CyberLink TrueTheater HD: select to up scale the original video to a higher
resolution version, which is sharper and artifact-free.

· CyberLink TrueTheater Color: select this option to dynamically adjust the
color saturation ratio in video, making it more vivid, without affecting skin
tones.

11. Click Convert when you are ready to convert the video files.

Note: select the Auto shut down after conversion option if you want
CyberLink Power2Go to automatically shut down your computer once it has
successfully converted and transferred the files.

· Click OK to close the window when the conversion is complete.
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Converting Audio for Mobile
Device
To convert audio files and then transfer them to a mobile device*, do this:

Note: * this feature is not available in some versions of CyberLink Power2Go.

1. In the new task window, click the Media Converter option and then Audio to
Mobile Device. The Audio to Mobile Device window displays.

2. Use the search pane (see Using the Search Pane for more information) to find
the audio files you want to convert.

Note: for best search results, make sure you set up the Power2Go library
before converting. Once you do this, the music files in the library are
organized for you on the Media tab in the search pane and become
searchable using the search field. See Library Preferences for more
information.

3. Select the files you want to convert and then drag and drop them in the
content area.

Note: you can also click the  button to add the audio files or the other
available buttons to reorder and preview the audio. If you want to extract the
audio from a video clip and include it on your mobile device, simply add the
video clip to the content area.

4. If you would like to edit or add effects to an audio file, select it and then click

the  button to edit it in CyberLink WaveEditor*. Please consult the help file in
CyberLink WaveEditor for detailed information on editing audio in that
program. Once you finish editing an audio file, the updated file is placed back
in the content area.

5. Once you have added all of the audio files you want to convert, click the Next
button.
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6. If required, connect your mobile device to your computer. CyberLink
Power2Go should detect your device automatically. If it doesn't, try clicking
the Auto Detect button or manually select the device brand and model from
the drop-downs.

7. Select the media format profile you want to use to convert the audio files
from the drop-down. If you want to create your own profile, select Custom
and then customize as follows:

Note: the Custom option is only available if a device brand and model are
selected.

· Format: select from the available audio file formats.

· Sampling rate: select from the available sampling rates, which helps define
the quality of the audio.

· Bitrate: select from the available audio compression rates, which helps define
the quality of the audio.

Click OK when done to use the custom profile.

8. If required, click the  button to change the folder where the converted
audio files are saved to before they are transferred to your mobile device.

9. If required, set the conversion settings as follows:

· Transfer to connected mobile device after conversion: select this option if you
want CyberLink Power2Go to transfer the converted audio files to a connected
mobile device once it has converted the files.

Note: if converting media for a connected Apple device, the Add converted
files to iTunes Library option is available instead. 

10. Click Convert when you are ready to convert the audio files.

Note: select the Auto shut down after conversion option if you want
CyberLink Power2Go to automatically shut down your computer once it has
successfully converted and transferred the files.

· Click OK to close the window when the conversion is complete.
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Rip Audio and Convert for
Mobile Device
To rip, convert, and then transfer audio to a mobile device*, do this:

Note: * this feature is not available in some versions of CyberLink Power2Go.

1. In the new task window, click the Media Converter option and then Audio CD
to Mobile Device. The Audio to Mobile Device window displays.

2. Insert your disc and then select your drive from the Select source drop-down.

3. If required, deselect any audio tracks that you don't want to rip and convert.

4. If required, click  next to an audio track to modify its information as
follows:

· Title: enter the audio track title.

· Artist: enter the artist information.

· Album name: enter the name of the album.

· Genre: enter the genre of the audio being ripped.

· Apply tags (except title and artist) to all tracks: select this option if you want to
apply the album name and genre to all the tracks to be converted.

Click OK when done.

5. When you are ready to rip and convert, click the Next button.

6. If required, connect your mobile device to your computer. CyberLink
Power2Go should detect your device automatically. If it doesn't, try clicking
the Auto Detect button or manually select the device brand and model from
the drop-downs.

7. Select the media format profile you want to use to convert the audio files
from the drop-down. If you want to create your own profile, select Custom
and then customize as follows:
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Note: the Custom option is only available if a device brand and model are
selected.

· Format: select from the available audio file formats.

· Sampling rate: select from the available sampling rates, which helps define
the quality of the audio.

· Bitrate: select from the available audio compression rates, which helps define
the quality of the audio.

Click OK when done to use the custom profile.

8. If required, click the  button to change the folder where the ripped and
converted audio files are saved to before they are transferred to your mobile
device.

9. If required, set the conversion settings as follows:

· Transfer to connected mobile device after conversion: select this option if you
want CyberLink Power2Go to transfer the converted audio files to a connected
mobile device once it has converted the files.

Note: if converting media for a connected Apple device, the Add converted
files to iTunes Library option is available instead. 

10. Click Convert when you are ready to convert the audio files.

Note: select the Auto shut down after conversion option if you want
CyberLink Power2Go to automatically shut down your computer once it has
successfully converted and transferred the files.

· Click OK to close the window when the conversion is complete.

Player for Mobile Device
CyberLink Power2Go includes direct access to Power Media Player, the award-
winning and powerful mobile media player for your Android or iOS device. Click
the Media Converter option and then Player for Mobile Device to view the available
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links and QR codes to download and install Power Media Player to play back your
converted videos and audio on your device.

Note: see the help file within Power Media Player for a detailed list of the
available features and descriptions of the program functions.

Ripping Audio
The Rip Audio function copies audio tracks from an audio CD to your hard drive in
the APE*, FLAC*, M4A* (AAC), MP3, OGG*, WAV, or WMA format.

Note: * this feature is not available in some versions of CyberLink Power2Go.

To rip audio files to your hard drive, do this:

1. In the new task window, select the Media Converter option and then Rip
Audio CD. 

2. Insert your disc and then select your drive from the Select source drop-down.

Note: if you insert a new disc or select a different drive, click  to refresh
and ensure the most updated information displays.

3. Select the audio tracks that you want to copy to your hard drive.

4. If required, click  next to an audio track to modify its information as
follows:

· Title: enter the audio track title.

· Artist: enter the artist information.

· Album name: enter the name of the album.

· Genre: enter the genre of the audio being ripped.

· Apply tags (except title and artist) to all tracks: select this option if you want to
apply the album name and genre to all the tracks to be converted.

Click OK when done.
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5. Click the  button and locate the folder that you want to copy the audio
tracks to.

6. In the Settings section, set the Format and Quality of the outputted audio
files.

7. Click Go to copy the files to your computer.

Converting Audio Files
Use the Audio Converter utility to convert existing audio into one of these audio
file formats: APE*, FLAC*, M4A* (AAC), MP3, OGG*, WAV, or WMA. You can also
output audio files with a different quality or extract audio from video clips.

Note: * this feature is not available in some versions of CyberLink Power2Go.

To convert audio files, do this:

1. In the new task window, select the Media Converter option and then Audio
Converter.

2. Click  and then select the files you want to convert. Click Open to add
them into the Audio Converter window.

3. Click the  button and then select the location where you want to save
the converted audio files.

4. In the Settings section, set the Format and Quality of the converted files from
the drop-downs.

5. Click Go to convert the audio files and save the files to your computer.
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Utilities
Chapter 11:

In addition to the wide range of disc burning functions, CyberLink Power2Go offers
some handy utilities for managing your discs. This includes a library of your burned
discs in the Disc Manager and an erase re-writable discs feature. The Utilities
window also provides access to creating mixed discs, the system recovery disc
creation feature, and the CyberLink Power2Go Virtual Drive.

Erasing a Disc
If you are using a re-writable disc, you can erase content that was previously
recorded onto it. This allows you to reuse the same discs over and over without the
need to continually buy new discs. 

To erase a disc, do this:

1. In the new task window, select the Utilities option and then Erase Disc.

2. Insert your disc and select your Burner from the drop-down.

3. Select one of the following erase methods:

· Quick erase: erases the disc index contained on the disc.

· Full erase: erases all of the content the disc contains.

4. Click Erase to start the erase process.

Power2Go Virtual Drive
The Power2Go Virtual Drive lets you mount a disc image file and access it as if it is a
real disc drive on your computer.

Mounting a Disc Image
To mount a disc image using the Power2Go Virtual Drive, do this:

1. In the new task window, select the Utilities option and then Virtual Drive. The
Power2Go Virtual Drive window displays.
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2. Select the Enable virtual drive option.

3. In the Image location field, click  and select the location of the image
you want to mount. CyberLink Power2Go supports the mounting of images in
the ISO, P2I (Power2Go image) or RDF formats.

4. Assign a Drive letter for the mounted disc image, by selecting it from the
drop-down. The drive letter you assign will be how you identify the mounted
drive in Windows Explorer.

5. Click on OK to mount the drive. The disc image will be available like any other
disc drive in Windows Explorer.

Note: the disc image stays mounted as a drive until you disable it, even if you
reboot your computer.

Disabling a Mounted Disc Image
To disabled a mounted disc image, do this:

1. In the new task window, select the Utilities option and then Virtual Drive. The
Power2Go Virtual Drive window displays.

2. Select the Disable virtual drive option.

3. Click on OK.

Burning Mixed Discs (CD
Extra/Mixed Mode CD)
In the Utilities window you can also create and burn mixed discs (CD Extra and
Mixed Mode CD). Mixed discs allow you to burn different types of media content
(data files and audio CD) to the same disc.

With the CD Extra feature you can create an audio CD that also contains your data
files. The Mixed Mode CD allows you to create a data CD that also contains audio
files the in audio CD format. These discs allow you to play the music on your
computer with the proper playback software, and also view the data files like a
normal data disc.
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Burning a CD Extra/Mixed Mode CD
To burn a CD Extra or Mixed Mode CD disc, do this:

1. In the new task window, select the Utilities option and then CD Extra or Mixed
Mode CD. The CD Extra/Mixed Mode CD window opens.

2. If you’re creating a CD Extra disc, do this:

· Drag and drop audio files to the middle pane. Dragging a folder to the pane
adds the files it contains, but does not create a folder on the disc.

· Drag and drop data files and folders to the bottom pane. Dragging a folder to
the pane creates a folder on the disc.

Note: if you add music files to the data pane, you cannot play them on a CD
player, as they are read as data files.

3. If you’re creating a Mixed Mode CD, do this:

· Drag and drop data files and folders to the middle pane. Dragging a folder to
the pane creates a folder on the disc.

· Drag and drop audio files to the bottom pane. Dragging a folder to the pane
adds the files it contains, but does not create a folder on the disc.

Note: you can also click the  button to add the files or the other available
buttons to reorder and preview the music on the disc.

4. If you would like to edit or add effects to an audio file, select it and then click

the  button to edit it in CyberLink WaveEditor*. Please consult the help file in
CyberLink WaveEditor for detailed information on editing audio in that
program. Once you finish editing an audio file, the updated file is placed back
in the content area.

5. If required, click the Edit button to add CD-Text, normalize the audio, and
more. See Audio CD Preferences for information on the available preferences.

6. Once you have added all of the content you want on your disc, click the Next
button.
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7. If required, adjust the options in General settings and the Burning Options.

8. Click Burn when you are ready to burn your disc.

Note: select the Auto shut down after burning option if you want CyberLink
Power2Go to automatically shut down your computer once it has
successfully burned your disc.

9. When burning is complete, select an option in the window that opens:

· Click the View Log link to view the burning log. The log opens in your default
TXT editor, where you can view and save it.

· Click Print Label to create a disc label for the disc in CyberLink LabelPrint, if it
is installed on your computer.

· Click Capture Label to take a photo snapshot that will be used to help identify
the burned disc it in the Disc Manager*.

Note: if you chose to print a disc label in CyberLink LabelPrint, you don't need
to capture the label as CyberLink Power2Go automatically imports the
created label into the Disc Manager. See Disc Label Snapshots for information
on viewing and editing the label snapshot.

· Click OK to close the window.

Note: * this feature is not available in some versions of CyberLink Power2Go.

Using the Disc Manager
The Disc Manager* is a library of all the discs you have created and burned using
CyberLink Power2Go. These discs are automatically imported for you after you
finished the burning task. You can also import discs you burned previously into the
Disc Manager library.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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In the new task window, select the Utilities option and then Disc Manager to open
the Disc Manager. Note that label snapshots in the Disc Manager window, as they
are there to help you find your burned discs more quickly.

To look for discs in the Disc Manager library, select tags on the left of the window to
filter the discs. You can also enter a keyword in the search field in the top left of the
window to search for a disc or files that were burned to them.

Right-click on a disc and select Disc Info to view information about when the disc
was created and more. To view the content that was burned to the disc in the
library, just double-click on it to view the files. If you want to view a file on the disc,
make sure the disc is in your disc drive and then double-click on the file.

Manually Importing Discs to the Disc
Library
In the Disc Manager you can import discs you created with older versions of
CyberLink Power2Go or burned in other programs. 

To import a disc into the Disc Manager library, do this:
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1. In the Disc Manager window, click . The Import Disc window opens.

2. Insert the disc you want to import into your disc drive, and then click OK.
CyberLink Power2Go will load the disc and then display the Disc Info window.

3. If required, click on  to add a label snapshot to help you identify the
disc in the Disc Manager library. See Editing the Disc Label Snapshot for more
information. 

Note: you must have a webcam or other video device attached your
computer to take the label snapshot.

4. If required, click on Edit Tags to add keyword search tags to the disc. See
Adding Tags to Discs for more information.

5. Click OK to close the window and add the disc into the Disc Manager library.

Disc Label Snapshots

Disc label snapshots are photos that help you identify the disc in the Disc Manager
library. If you created a disc label using CyberLink LabelPrint, it is automatically
imported and used as the label snapshot in the Disc Manager.

You can edit the captured label snapshot or add a new one by taking a photo of
hand drawn text on the disc, drawings, or whatever you want and use it as the label
snapshot.

Editing the Disc Label Snapshot

To edit the disc label snapshot, do this:

1. If in the Disc Info window, click the  button to open the Capture Label
Snapshot window.

2. If required, select the device you want to use to capture the snapshot from the
drop-down.

3. Hold the disc or other item up to your webcam and then click . If you
don't like the snapshot that was taken, you can recapture it by repeating this
step.
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4. Once you are satisfied with the label snapshot, click on Done.

Adding Tags to Discs

Keyword search tags are used to help you find discs in the Disc Manager library.
You can easily filter or search for these tags to help you find the discs.

To add tags to discs, do this:

1. If in the Disc Info window, click the Edit Tags button to open the Edit Tag
window.

2. If required, add any of the existing tags by selecting the check box next to
them.

3. To add a new tag, enter the new tag name in the field provided and then click

on .

4. Once you are done selecting and adding all the tags, click on OK to save the
changes.

System Recovery
The System Recovery* feature in CyberLink Power2Go is a computer system
backup and recovery solution that helps protect your computer, and its data,
against unforeseen events, such as virus attacks, system crashes, and hard disk
failures.

CyberLink Power2Go helps you create a system recovery backup on a disc or
removable USB storage drive. The backup will include the Windows operation
system programs and a backup of all the data files that are currently on your
computer.

Note: * this feature is not available in some versions of CyberLink Power2Go.
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Creating a System Recovery on USB drive
To back up your computer on a removable USB storage drive, do this:

Install Windows Assessment and Deployment Kit
(ADK) for Windows 10

Download and install Windows Assessment and Deployment Kit (ADK) and the
Windows PE add-on for Windows 10 before creating the system recovery disk: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows
10 by clicking the "Download the Windows ADK for Windows 10, version
XXXX" link on the following Microsoft web page: 
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx

Note: you can check out this FAQ for more information:
https://www.cyberlink.com/support/faq-content.do?id=18414

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\10\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step. If using Windows 64bit,
then select <Program Files (x86)>\Windows Kits\10\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim.

3. Download the Windows PE add-on for the ADK for Windows 10 by clicking the
"Download the Windows PE add-on for the ADK" link on the following
Microsoft web page: https://msdn.microsoft.com/en-
us/windows/hardware/dn913721.aspx

4. Install the Windows PE add-on.

Install Windows Assessment and Deployment Kit
(ADK) for Windows 8.1

https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
https://www.cyberlink.com/support/faq-content.do?id=18414
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
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Download and install Windows Assessment and Deployment Kit (ADK) for Windows
8.1 before creating the system recovery disk: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows
8.1: https://www.microsoft.com/en-us/download/details.aspx?id=39982.

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\8.1\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step.

Install Windows Assessment and Deployment Kit
(ADK) for Windows 8

Download and install Windows Assessment and Deployment Kit (ADK) for Windows
8 before creating the system recovery disk: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows 8:
https://www.microsoft.com/en-us/download/details.aspx?id=30652.

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\8.0\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step.

Install Windows Automated Installation Kit (AIK) for
Windows 7

Download and install Windows Automated Installation Kit (AIK) before creating the
system recovery disk:

1. Download the Windows Automated Installation Kit (AIK) for Windows 7: 
https://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-
9F76-4177-A811-39C26D3B3B34&displaylang=en.

http://www.microsoft.com/en-us/download/details.aspx?id=39982
http://www.microsoft.com/en-us/download/details.aspx?id=30652
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
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2. Burn the downloaded .iso file to a DVD disc or use virtual drive to mount the
downloaded .iso file.

3. Install Windows AIK.

4. The changes will take effect when Power2Go is restarted.

Note: if the Power2Go program cannot detect your installed AIK location
properly, please select <Program Files>\Windows
AIK\Tools\PETools\amd64\winpe.wim in the Burn Recovery Disc final step.

Creating System Recovery on USB Drive

1. In the new task window, select the Utilities option and then select System
Recovery on USB Drive. The first wizard window opens.

2. Ensure the removable USB storage drive is inserted into one of your
computer's USB ports, and then click the Next button to proceed to the next
wizard window.

Note: Windows may display the User Account Control dialog asking you if
CyberLink Power2Go is allowed to make changes to your computer. If you
see this dialog, click Yes to proceed. If you click No, you cannot create a
system recovery disk.

3. If required, click  to browse to and then select the location of the installed
ADK/AIK.

Note: refer to the ADK/AIK installation instructions above for the location of
the installed kit on your computer.

4. Ensure the correct removable USB storage drive is selected.

5. Enter any Backup notes that you may want to include on the recovery disk,
such as the computer name or the date the backup was performed.

6. Click the Start Backup button and then OK to begin backing up your
computer onto the removable USB storage drive.
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7. Continue to follow the steps in the wizard windows to finish the backup
process. Click Done once finished.

Burning a System Recovery on a Disc
To back up your computer and burn a system recovery disc, do this:

Install Windows Assessment and Deployment Kit
(ADK) for Windows 10

Download and install Windows Assessment and Deployment Kit (ADK) and the
Windows PE add-on for Windows 10 before creating the system recovery disk: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows
10 by clicking the "Download the Windows ADK for Windows 10, version
XXXX" link on the following Microsoft web page: 
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx

Note: you can check out this FAQ for more information:
https://www.cyberlink.com/support/faq-content.do?id=18414

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\10\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step. If using Windows 64bit,
then select <Program Files (x86)>\Windows Kits\10\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim.

3. Download the Windows PE add-on for the ADK for Windows 10 by clicking the
"Download the Windows PE add-on for the ADK" link on the following
Microsoft web page: https://msdn.microsoft.com/en-
us/windows/hardware/dn913721.aspx

4. Install the Windows PE add-on.

https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
https://www.cyberlink.com/support/faq-content.do?id=18414
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
https://msdn.microsoft.com/en-us/windows/hardware/dn913721.aspx
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Install Windows Assessment and Deployment Kit
(ADK) for Windows 8.1

Download and install Windows Assessment and Deployment Kit (ADK) for Windows
8.1 before burning the system recovery disc: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows
8.1: https://www.microsoft.com/en-us/download/details.aspx?id=39982.

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\8.1\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step.

Install Windows Assessment and Deployment Kit
(ADK) for Windows 8

Download and install Windows Assessment and Deployment Kit (ADK) for Windows
8 before burning the system recovery disc: 

1. Download the Windows Assessment and Deployment Kit (ADK) for Windows 8:
https://www.microsoft.com/en-us/download/details.aspx?id=30652.

2. Install Windows ADK.

Note: if the Power2Go program cannot detect your installed ADK location
properly, please select <Program Files>\Windows Kits\8.0\Assessment and
Deployment Kits\Windows Preinstallation Environment\amd64\en-
us\winpe.wim in the Burn Recovery Disc final step.

Install Windows Automated Installation Kit (AIK) for
Windows 7

Download and install Windows Automated Installation Kit (AIK) before burning the
system recovery disc:

http://www.microsoft.com/en-us/download/details.aspx?id=39982
http://www.microsoft.com/en-us/download/details.aspx?id=30652
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1. Download the Windows Automated Installation Kit (AIK) for Windows 7: 
https://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-
9F76-4177-A811-39C26D3B3B34&displaylang=en.

2. Burn the downloaded .iso file to a DVD disc or use virtual drive to mount the
downloaded .iso file.

3. Install Windows AIK.

4. The changes will take effect when Power2Go is restarted.

Note: if the Power2Go program cannot detect your installed AIK location
properly, please select <Program Files>\Windows
AIK\Tools\PETools\amd64\winpe.wim in the Burn Recovery Disc final step.

Burn System Recovery Disc

1. In the new task window, select the Utilities option and then select System
Recovery on Disc. The first wizard window opens.

2. Click the Next button to proceed to the next wizard window.

Note: Windows may display the User Account Control dialog asking you if
CyberLink Power2Go is allowed to make changes to your computer. If you
see this dialog, click Yes to proceed. If you click No, you cannot create a
system recovery disk.

3. If required, click  to browse to and then select the location of the installed
ADK/AIK.

Note: refer to the ADK/AIK installation instructions above for the location of
the installed kit on your computer.

4. Ensure the correct burning drive is selected.

5. Select the Disc type you want to back up the Windows files and data on from
the drop-down.

http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
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Note: the disc type you select should be based on the burning drive you have
installed in your computer and the type of optical discs you have on hand.

6. Enter any Backup notes that you may want to include on the recovery discs,
such as the computer name or the date the backup was performed.

7. Click the Start Backup button to begin backing up your computer and
burning the system recovery discs. If more than one disc is required to create
the system recovery discs, you will be prompted to insert the next disc to
proceed.

8. Continue to follow the steps in the wizard windows to finish the backup
process. Click Done once finished.

Restoring Your Computer

Restoring from a Created System Recovery Disk on a
Removable USB Storage Drive

To restore your computer from a system recovery disk, do this:

1. Insert the removable USB storage drive you created the system recovery disk
on previously into one of your computer's USB ports.

2. Restart your computer.

3. The System Recovery Restore wizard will display once your computer has
restarted.

4. Click the Next button to proceed, and then Start to begin the restoration
process.

5. Follow all the steps in the wizard to restore your computer.

6. Once the restore is complete, click Shut Down to turn off your computer or
Reboot to log back into Windows.

Note: if you want to reboot your computer, make sure you remove the
removable USB storage drive from the USB port.
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Restoring from a System Recovery Disc

To restore your computer from a system recovery disc, do this:

1. Insert the first system recovery disc created previously into your computer's
disc drive.

2. Restart your computer.

3. The System Recovery Restore wizard will display once your computer has
restarted.

4. Click the Next button to proceed, and then Start to begin the restoration
process.

5. Follow all the steps in the wizard to restore your computer.

6. Once the restore is complete, click Shut Down to turn off your computer or
Reboot to log back into Windows.

Note: if you want to reboot your computer, make sure you remove the
system recovery disc from the disc drive.

Launching LabelPrint
The last step to creating your disc is making a label for it. You can do this in the
CyberLink LabelPrint program, which you can open by clicking Launch LabelPrint in
Utilities.

Note: CyberLink Power2Go sends the title and other information from your
created disc to LabelPrint. This information is added to the title and track
fields respectively, so you do not have to reenter this information when
creating your disc label. Once the label is created, it is automatically imported
into the Disc Manager to help you identify it later.

See the help file in that program for detailed information about creating disc labels.
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Additional Burning Notes
and Features

Chapter 12:

The following are some additional burning notes and features for CyberLink
Power2Go that you may find extremely useful when burning discs.

Using the CyberLink ISO Viewer
With CyberLink Power2Go you can use the CyberLink ISO Viewer to view disc
images in the ISO, P2I (Power2Go image), or RDF format on your computer’s hard
drive. This convenient tool lets you view the contents of an image file, and quickly
extract files or burn the image to a disc. 

You can launch the CyberLink ISO Viewer by selecting CyberLink ISO Viewer 12
option from the Windows start menu, or right-clicking on an image file on your
hard drive and then selecting CyberLink ISO Viewer 12.

When in the CyberLink ISO Viewer, you can perform the following functions:
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· click the  button to browse to and open an image file (in the ISO, P2I or
RDF format) on your computer. When opened, you can see all the files
contained within the image.

Note: to change the view of the files in the CyberLink ISO Viewer, click .

· click on a file in the CyberLink ISO Viewer and then click  to view it in its
default program.

· to extract files from the image and save them to your computer, select them

and then click .

· if you want to burn the image you are viewing to a disc, click the  button.
See Burning a Disc Image for more detailed information about burning disc
images.

· if you want to mount the image as a drive on your computer, click the 
button. See Mounting a Disc Image for more detailed information about
mounting disc images.

Multisession Discs
When you burn a data disc in CyberLink Power2Go, you can create a multisession
disc that lets you burn additional content to a disc that is not full. CyberLink
Power2Go creates a multisession disc whenever you burn a CD, DVD or Blu-ray Disc
and choose not to close the disc.

Note: multisession discs are created when the Close disc option on the
Options tab is not selected during burning. See Configuring the Burning
Options for more information.

With multisession discs you can continue to add content it until the disc is full or
closed, at which point you can no longer add any further data.
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Power2Go Preferences
Chapter 13:

Use the CyberLink Power2Go preferences to set the program's temporary directory,
UI language, capacity preferences, and more. To open the preferences window,
select Edit > Preferences from the menu in the new function window, or click on

the  button when in the new task window.

General Preferences
Click the  button (or select Edit > Preferences in the new function window) to
open the Preferences window, and then select the General tab, to set the general
preferences as follows:

· Temporary directory: allows you to set a working directory that CyberLink
Power2Go uses to store temp files during the burning process.

Note: the amount of disk space available on the drive that contains the
temporary directory should meet or exceed the suggested hard disk space
requirements in System Requirements. This is because CyberLink Power2Go
creates and stores the temp file in this folder, before burning it to disc.

· Reset all don't show again in dialogs: click the Reset button to reset the all the
"Don't show again" checkboxes in the program's message dialogs back to the
default settings. All of the message dialogs that contain the "Don't show
again" checkbox will display again after this button is clicked.

· Print disc label after burning: select this option if you want CyberLink
Power2Go to display the Print Label button on the burning confirmation
window. If you have CyberLink LabelPrint installed, you can then click this
button to create a disc label for your burned disc.

· Run desktop burning gadget at Windows startup: select if you want the
Desktop Burning Gadget to auto launch whenever you turn on your
computer.

· Automatically add disc info into the Disc Manager library when burning discs:
select this option if you want CyberLink Power2Go to automatically add all of
the discs you burn into the Disc Manager library.
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· Check for product update information: select this option to have CyberLink
Power2Go periodically check for program updates.

· Eject disc after burning: select this option if you want CyberLink Power2Go to
automatically eject the disc once the burning is complete.

· I want to participate in the CyberLink Product Improvement Program: select
this item if you would like to participate in the CyberLink Product
Improvement Program for Power2Go. Once enabled, CyberLink Power2Go will
collect information about the hardware and software configuration of your
computer system, as well as your usage behavior and statistics related to the
software. Click the Learn more link to view more detailed information about
the content collected.

Capacity Preferences
Click the  button (or select Edit > Preferences in the new function window) to
open the Preferences window, and then select the Capacity tab to set a custom disc
size when burning content to CD, if you are using discs that can hold more than 700
MB. The preferences are as follows:

· Auto detection: enables CyberLink Power2Go to automatically detect a disc’s
capacity.

· Customize CD-R/RW capacity: select this option and then enter the new size
(in minutes) in the field provided to manually set a disc’s capacity. 

Library Preferences
Click the  button (or select Edit > Preferences in the new function window) to
open the Preferences window, and then select the Library tab to enable music
information download when creating music discs and also add folders into the
Power2Go library as follows:

· Automatically retrieve album/disc information from the Internet: select this
option to have CyberLink Power2Go automatically retrieve song and album
information when ripping audio files.

· In the library section of the Library preferences tab you can add or remove
monitored folders from the Power2Go library. To add a folder, click the Add
button, browse to and then select the folder you want to add, and then click 
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OK. CyberLink Power2Go will monitor these folders, and any new music,
video, or data files added to them will be automatically added into the library.

Note: the Power2Go library is helpful when creating music and data discs, or
converting audio and video files. Music in the added folders is organized for
you in the search pane's Media tab when creating a music disc. Also, music,
video, and data files in these folders become searchable in the search field
when creating a music or data disc, or when converting video and audio files
in the Media Converter.

Language Preferences
Click the  button (or select Edit > Preferences in the new function window) to
open the Preferences window, and then select the Language tab to set the user
interface language preferences as follows:

· Use system default language (if supported): select this option if you want the
CyberLink Power2Go language display to be the same as the default language
of your operating system. This feature is only available if your operating
system's language is one of the supported user defined languages.

· User defined: select this option and then select the language from the drop-
down list that you want CyberLink Power2Go to use.
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Power2Go Settings
Chapter 14:

This chapter outlines the steps for configuring the settings used to burn discs and
download online media in CyberLink Power2Go. The Settings/Information window
displays automatically after you click the Next button during the burn/download
process.

To manually open the Settings/Information window, select Burning > Settings from
the menu when creating a disc, or press Ctrl+I on your keyboard.

Note: the options and tabs that display in the Settings/Information window is
dependent on the task you selected.

General Settings
When the Settings/Information window displays after you click the Next button
during the burn/download process, select the General tab to configure the
following options. To access it manually, select Burning > Settings from the menu
when creating a disc, or press Ctrl+I on your keyboard, and then select the General
tab.

· Disc name: enter a name for the disc, which can be up to 16 characters long.
The disc name appears on a disc player during playback and is used to help
identify it in the Disc Manager.

· Burner: displays the burner drive that CyberLink Power2Go will use to burn
the disc. You can change which burner drive is used in the new function
window.

· Write speed: select a write speed from the drop-down list. The speeds that are
available is dependent on the drive installed in your computer.

· Copies: enter the number of copies of the disc you want to burn.

· Disc Manager tags: if required, click the Edit Tags button to add and edit
keyword search tags for the disc you are burning. Tags will help you find the
burned disc in the Disc Manager* library more quickly when you are searching
for it on a later date. See Adding Tags to Discs for more information.
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Note: * this feature is not available in some versions of CyberLink Power2Go.

Burning Options
When the Settings/Information window displays after you click the Next button
during the burn/download process, select the Options tab to configure the
following options. To access it manually, select Burning > Settings from the menu
when creating a disc, or press Ctrl+I on your keyboard, and then select the Options
tab.

Note: the options that are available on this tab is dependent on the burning
task you selected.

· Make auto-run disc: select this option if you want the disc to automatically
open a selected file when the disc is inserted into a drive. Click Browse to
select the file you want opened when the disc is inserted. The file can be an
EXE, HTML, or TXT file.

· Change disc icon: for some discs you can change the icon that appears when
it is viewed in Windows Explorer. Click Browse and then select the image in
the ICO file format that you want to use.

· Auto-split content by disc capacity: select this option to automatically divide
the files you are burning into volumes (portions) according to the size of the
destination disc.

· File system: if available, set the file system (ISO9660/Joliet, UDF 1.5, UDF 2.0,
UDF 2.5, or UDF 2.6) you want the disc to have.

· Enable buffer underrun protection: select this option to ensure that data is
written to disc without interruption. An interruption in data can result in an
unusable disc.

· Write simulation before burning: select this option to perform a write
simulation first to verify that your burner can burn to the disc at the selected
speed without encountering any errors.

Note: if you have enabled buffer underrun protection or have previously
burned discs using the current settings, you do not need to run a simulation.
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· Close disc (no further data can be added): select this option to write-protect a
disc. Once burned, no further data can be added to the disc. If you do not
select this option, you can create a multisession disc. See Multisession Discs
for more information.

· Verify recorded data: select this option if you want CyberLink Power2Go to
verify that the content was successfully burned to the disc. Select Quick
verification to have CyberLink Power2Go quickly verify the correctness of the
data, or Complete verification to check all of the data individually. The latter
requires more time to complete the verification.

· Enable defect management: select this option to have CyberLink Power2Go try
to fix any defects on a disc so that content burns correctly.

Burned file dates

· Use the original date and time: select this option to use each file’s original date
and time for the date info used for the files burned on the disc.

· Use the current date and time: select this option to use the current date and
time for the date info used for the files burned on the disc.

· Use this date and time: select this option to manually enter a specific date and
time in the fields provided for the date info used for the files burned on the
disc.

Info Tab
When the Settings/Information window displays after you click the Next button
during the burn/download process, select the Info tab to display the details and
specification of the selected disc drive, the disc in the drive, as well as the current
project. To access it manually, select Burning > Settings from the menu when
creating a disc, or press Ctrl+I on your keyboard, and then select the Info tab.

Click the + next to an item to view more detailed information. If you insert a new

disc or select a different drive, click  to refresh and ensure that the most
updated information is displayed.

Download Settings
The Download* settings tab displays when backing up your online media to a disc
or downloading it to your computer's hard drive. To access it manually, select 
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Burning > Settings from the menu when performing an online media backup, or
press Ctrl+I on your keyboard. On this tab, configure the settings as follows:

· Download retry count: select the number of times CyberLink Power2Go
should try and download a file from an online media site before giving up.

· Download thread count: select the number of files CyberLink Power2Go can
download at one time from an online media site.

· Delete temporary files after burning: when backing up online media to a disc,
select this option if you want CyberLink Power2Go to delete all of the
downloaded media files from the temporary folder after burning them to the
disc.

· Temporary folder: when backing up online media to a disc, this is the folder
where the online media files are downloaded to before they are burned to the
disc. This is also where the online media files are downloaded and stored
when not burning them to a disc. If required, click the Select Folder button to
specify a different folder on your computer. 

Note: * this feature is not available in some versions of CyberLink Power2Go.

Video Settings
The Video* settings tab displays if you select Burning > Settings, or Ctrl+I on your
keyboard, when creating a video disc. On this tab, configure the settings as follows
when burning a DVD, Blu-ray Disc, or AVCHD disc:

GPU acceleration preferences

· Enable hardware video decoding* (if available): if your computer supports
Intel Core Processor Family Technology, NVIDIA CUDA, or AMD Accelerated
Parallel Processing, select this option to use hardware acceleration to decode
video to speed up the creation of video discs.

· Enable hardware video encoding* (if available): if your computer supports
Intel Core Processor Family Technology, NVIDIA CUDA, or AMD Accelerated
Parallel Processing, select this option to use hardware acceleration to encode
video to speed up the creation of video discs. 

Note: * this feature is not available in some versions of CyberLink Power2Go.
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Technical Support
Chapter 15:

If you require technical support, then this chapter can help. It includes all the
information you need to find the answers you are looking for. You may also find
answers quickly by contacting your local distributor/dealer.

Before Contacting Technical
Support
Before contacting CyberLink technical support, please take advantage of one or
more of the following free support options: 

· consult the user’s guide or the online help installed with your program. 

· refer to the Knowledge Base at the following link on the CyberLink web site:
https://www.cyberlink.com/support/search-product-result.do 

· check the Help Resources page in this document.

When contacting technical support by e-mail or phone, please have the following
information ready:

· registered product key (your product key can be found on the software disc
envelope, the box cover, or in the e-mail received after you purchased
CyberLink products on the CyberLink store).

· the product name, version and build number, which generally can be found
by clicking on the product name image on the user interface.

· the version of Windows installed on your system.

· list of hardware devices on your system (capture card, sound card, VGA card)
and their specifications. For fastest results, please generate and attach your
system info using the DxDiag.txt.

Note: here are the steps to generate the system info DxDiag.txt file: Click
Windows (start) button, and then search for "dxdiag". Click Save All
Information button to save the DxDiag.txt file.
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· the wording of any warning messages that were displayed (you may want to
write this down or take a screen capture).

· a detailed description of the problem and under what circumstances it
occurred.

Web Support
Solutions to your problems are available 24 hours a day at no cost on the CyberLink
web site:

Note: you must first register as a member before using CyberLink web
support.

CyberLink provides a wide range of web support options, including FAQs, in the
following languages:

Language Web Support URL

English https://www.cyberlink.com/cs-help

Traditional Chinese https://tw.cyberlink.com/cs-help

Japanese https://jp.cyberlink.com/cs-help

Spanish https://es.cyberlink.com/cs-help

Korean https://kr.cyberlink.com/cs-help

Simplified Chinese https://cn.cyberlink.com/cs-help

German https://de.cyberlink.com/cs-help

French https://fr.cyberlink.com/cs-help

Italian https://it.cyberlink.com/cs-help

Help Resources
The following is a list of help resources that may assist you when using any of
CyberLink's products.

· Access CyberLink's Knowledge base and FAQ (frequently asked questions):
https://www.cyberlink.com/cs-resource
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· View video tutorials for your software:
https://directorzone.cyberlink.com/tutorial/

· Ask questions and get answers from our users on the CyberLink Community
Forum: https://forum.cyberlink.com/forum/forums/list/ENU.page

Note: CyberLink’s user community forum is only available in English and
German.
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